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Chapter 1:  Introduction 

1.1 What Is CHECK-RAS? 

The CHECK-RAS program uses a series of checking routines to check the 
reasonableness of data from HEC-RAS files.  HEC-RAS is the U.S. Army Corps of 
Engineers, Hydrologic Engineering Center, River Analysis System program. 
CHECK-RAS uses the data from the HEC-RAS geometric, steady flow, and output files 
to verify that the hydraulic estimates and assumptions made in the model appear to be 
justified, are in accordance with the applicable Federal Emergency Management Agency 
(FEMA) requirements, and are compatible with assumptions and limitations of the 
HEC-RAS program. 

CHECK-RAS allows users to examine a variety of parameters from HEC-RAS data files, 
as well as generate, view, and print reports, which include tables and messages warning 
about problems with the HEC-RAS input and output.  Users can reference additional 
information about the warning messages by using the Help Message database. 

CHECK-RAS checking routines cover the following five areas: 

 NT (Manning’s Roughness Coefficients and Transition Loss Coefficients)


 XS (Cross Sections)


 Structures


 Floodways


 Profiles


Although HEC-RAS also provides some warning messages, CHECK-RAS, version 1.1, 
differs from HEC-RAS in that it does the following: 

 Categorizes floodplain modeling into five distinct areas of checks 

 Provides a summary table and warning messages for each checked area 

 Assesses the suitability of roughness coefficients and transition loss coefficients 

 Assesses the suitability of starting water-surface elevations 

 Assesses bridge and culvert modeling 

 Provides a detailed floodway analysis 

 Compares important parameters among multiple profiles 

 Proposes solutions through the use of the Help screens 

While CHECK-RAS will certainly lead to the production of more accurate HEC-RAS 
models, the program is not intended to be a replacement for engineering judgment. The 
program flags areas of potential error or concern; however, the user must 
determine if modifications to the HEC-RAS model are warranted. 
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1.2 How to Use the CHECK-RAS User’s Manual 

The CHECK-RAS User’s Manual contains instructions and specifications for running 
CHECK-RAS, version 1.1, successfully.  The manual is not intended to explain how to 
use HEC-RAS.  A basic knowledge of HEC-RAS and familiarity with the HEC-RAS User's 
Manual and Hydraulic Reference Manual are necessary to understand the error and 
warning messages CHECK-RAS provides. 

Prior to running CHECK-RAS for the first time, users should: 

 Have a good understanding of stream hydraulics, 

	 Be familiar with the U.S. Army Corps of Engineers (USACE) HEC-RAS 
program and the HEC-RAS User's Manual and Hydraulic Reference Manual, 

 Have a basic understanding of Microsoft Windows, and 

 Read this manual. 

This manual references an assortment of HEC-RAS variables and parameters without 
providing complete descriptions.  For a complete description of HEC-RAS variables and 
parameters, please refer to the HEC-RAS User’s Manual and Hydraulic Reference 
Manual, version 2.2, September 1998, Davis, California. 

This manual takes the user through the program using many illustrations of the various 
menus, input screens, and results screens.  After reading the manual, the user should 
be ready to start using the program. Throughout the manual, the user is asked to 
select items from pull-down menus or click on objects.  Unless otherwise noted, the 
user should left-click to select an item. 

The text of certain CHECK-RAS operational features has been enhanced to help the 
user.  Enhanced text features include: 

 Main Menu Button Bar Icons are placed in a box; 

 Command Buttons and Text Fields are underlined; and 

 Windows are in bold. 
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Chapter 2: Installing CHECK-RAS 

2.1 System Requirements 

CHECK-RAS, version 1.1, will run under Microsoft Windows 95/98/NT operating 
systems. 

2.2 Installation Procedures 

The user must uninstall any previous versions of CHECK-RAS before installing 
CHECK-RAS, version 1.1. If no previous version exists on the computer, please follow 
the procedures under the section “Installing CHECK-RAS.” 

Uninstalling CHECK-RAS 

The following steps should be followed to uninstall a previous version of CHECK-RAS: 

1.	 Click Start button from the Windows 95/98/NT taskbar, point to Settings, and click 
Control Panel. 

2. From Control Panel, double click Add/Remove Programs button. 

3. From the list of programs displayed, click CHECK-RAS. 

4. Click Remove on Add/Remove Programs button. 

5. Click Yes to the question, click OK, and close the window. 

All of the program files related to CHECK-RAS will be removed.


Installing CHECK-RAS


From a CD-ROM:


1.	 On most recent systems, the CD-ROM drive is designated as drive E.  The following 
steps refer to drive E.  If necessary, substitute the appropriate drive letter. 

2. Insert the CD in the CD-ROM drive. 

3.	 Click the Start button and click Run. The Run window will appear.  In the Open 
box, enter the letter for the CD-ROM drive, a backslash, and the word Setup (i.e., 
“E:\setup”).  Click OK. 

4. The CHECK-RAS Setup window will appear.  Follow the instructions on the screen. 
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5.	 Accept the default destination location “C:\Program Files\Checkras,” or use Change 
Directory to choose a different location.  After CHECK-RAS is installed successfully, 
close the window. 

From the Internet: 

1.	 Download the zipped file from the Internet to a local directory (e.g., “C:\Install”) on 
your computer. 

2. Unzip the file and double click on “Setup.exe” to install the program. 

3. The CHECK-RAS Setup window will appear.  Follow the instructions on the screen. 

4.	 Accept the default destination location “C:\Program Files\Checkras,” or use Change 
Directory to choose a different location.  After CHECK-RAS is installed successfully, 
close the window. 

Running CHECK-RAS is explained in the following chapter. 
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Chapter 3: Running CHECK-RAS 

3.1 How CHECK-RAS Operates 

CHECK-RAS runs within Microsoft Windows.  It displays a series of menus and 
windows.  When running CHECK-RAS, version 1.1, the first time, a HEC-RAS Report file 
must be created through the CHECK-RAS program. While the HEC-RAS Report file is 
being created, CHECK-RAS inserts a table, CHECKRAS Table, under User Tables in the 
HEC-RAS Profiles Data window. The CHECKRAS Table includes variables that are not 
available from Standard Tables or from Detailed Output Data in HEC-RAS. 

Once the CHECKRAS Table is inserted into HEC-RAS User Tables, users may generate 
the HEC-RAS Report file directly from the HEC-RAS program. CHECK-RAS then 
extracts data from the HEC-RAS Report file.  A detailed explanation on creating the 
HEC-RAS Report file appears in Section 3.3 “Creating a HEC-RAS Report File for 
Subsequent Runs.” 

After extracting the data from the HEC-RAS Report file, CHECK-RAS displays the name 
of the profiles from the last executed plan in the Select Profile window.  Users can then 
select a single profile to analyze any single flood recurrence interval, two profiles for a 
floodway analysis, or two to four profiles for a multiple profile analysis. Users can also 
select the profiles by clicking the Select Profile option under program menu from the 
CHECK-RAS main window to select different profiles or analyses. 

If the single profile is chosen, the NT, XS, and Structure Checks can be run.  If two 
profiles are chosen for a floodway analysis, the NT, XS, Structure, and Floodway Checks 
can be run.  For a floodway analysis, the profiles should include the 1% annual chance 
discharge.  If multiple profiles are chosen, only the Profiles Check can be run.  When 
multiple profiles are chosen, the discharges among the selected profiles must be in 
increasing order. 

After selecting the profiles, users can click one of the “Check” buttons from the 
CHECK-RAS main window to have CHECK-RAS perform the checks. When the 
Floodway button is selected, CHECK-RAS uses a dialog box to ask whether the default 
surcharge value of 1.0 foot will be used.  To change from the default surcharge, select 
No, and the Select Allowable Surcharge window will be displayed.  See Section 3.9 
“Select Allowable Surcharge Window” for a detailed explanation of this window. 

The user can use either the menu bar or tool bar to run the CHECK-RAS program. 
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3.2 Running CHECK-RAS for the First Time 

The following procedure must be followed when running CHECK-RAS, version 1.1, for 
the first time. 

1.	 Open the HEC-RAS program and select the project and the plan.  Run the plan. 
Click User Tables menu in the Profile Output Table window, and check whether 
there is a table called CHECKRAS. (If User Tables menu is not in the window user 
must create one user-defined table.)  If there is, delete the table. There must be one 
user-defined table left under the User Tables. The CHECK-RAS program will insert 
the correct CHECKRAS table in step 4, below.  Close the HEC-RAS program.  If there 
is a file with “rep" as an extension, delete it from the directory where the project and 
the plan reside by using a program such as Windows Explorer. 

2.	 Click the Start button from the Windows taskbar, point to Programs, point to 
CHECK-RAS, and click the CHECK-RAS icon. The CHECK-RAS opening screen will 
briefly display, and the CHECK-RAS main window, as shown in Figure 1, will 
appear. 

Figure 1.  Main Window in CHECK-RAS 
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3.	 Click the File menu, and click the HEC-RAS Setup option. The HEC-RAS Program 
Setup dialog box shown in Figure 2 will appear. If the dialog box is blank, click the 
Browser button.  Locate the “ras.exe” file and click on it.  CHECK-RAS will place the 
path in the HEC-RAS Program Setup dialog box. The same procedures can be 
followed to select a default directory from which you want CHECK-RAS to retrieve 
the project file.  After making the selections, click OK. 

Figure 2. HEC-RAS Program Setup Dialog Box in CHECK-RAS 

Click the Open button from the CHECK-RAS main window. Locate the directory in 
which the project file that was used in the first step resides.  Double click the project 
file. 

Click the Extract Data button from the CHECK-RAS main window. Because the 
report file has been deleted in the first step, the dialog box shown in Figure 3 will 
appear. 

Figure 3.  Create HEC-RAS Report File Message in CHECK-RAS 

July 2000 8 



CHECK-RAS USER’S MANUAL


4.	 Click the OK button. The HEC-RAS window will appear with the latest plan that 
was run for the selected project.  Click the File menu from the HEC-RAS window 
and click the Generate Report option. The Report Generator window, as shown in 
Figure 4 will appear.  At this step, CHECK-RAS will insert the CHECKRAS Table in 
the User Tables of HEC-RAS and display it in the Selected Summary Tables box in 
the Report Generator window. If it is not there, user should search through the 
Available Summary Tables box and double click on the CHECKRAS Table. 

Please note that all the boxes under Input Data should be checked, and all but one 
box, Flow Distribution, under Specific Tables (Detailed Output) should be checked. 
The Summary of Errors, Warnings and Notes box is not checked. Users must 
ensure that the number of profiles shown under Profiles to Include in Report is 
correct.  Otherwise, click the Set Profiles button and select the profiles to be 
reviewed. Only CHECKRAS must be displayed in the Selected Summary Tables box. 
The Report Generator window must be configured in this way; otherwise, CHECK-
RAS will not be able to extract the data properly. 

Figure 4.  Report Generator Window in HEC-RAS 
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5.	 Click the Generate Report button from the Report Generator window, and when the 
View Report button appears, click the Close button. Close the HEC-RAS main 
window. 

6.	 Click the Extract Data button from the CHECK-RAS main window. The Data 
Extraction dialogue box will appear and show the progress made in data extraction. 
Once the data are extracted, the Select Profile window, as shown below, will 
appear. 

7.	 To check the single profile for the NT (Manning’s n and Transition Loss Coefficient) 
Check, XS (Cross-Section) Check, and Structure Check, click the circle in front of 
the 100-year Profile, and click the correct profile from the right-hand most box.  To 
check the floodway run for the NT Check, XS Check, Floodway Check, and Structure 
Check, two profiles must be selected from the right-hand most box.  First, click the 
circle in front of the 100-year Profile and click the correct profile from the right-hand 
most box. Then click the circle in front of the Floodway Profile, and click the 
appropriate profile from the right-hand most box.  For Multiple Profiles Check, 
circles in front of 10-year Profile, 50-year Profile, 100-year Profile, and 500-year 
Profile in the Multiple Profiles box are clicked one at a time, and the corresponding 
profile is clicked from the right-hand most box.  For flood insurance studies, it is 
advisable to name the profiles as 10-year, 50-year, 100-year, 500-year, and floodway 
so that the profiles can be selected with ease.  The profile names can be changed 
from the Rename Flow Title option under the File menu in the Steady Flow Data 
window of the HEC-RAS program. 

Figure 5.  Select Profile Window in CHECK-RAS 
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8.	 After selecting the profiles, click the NT, XS, Structure, Floodway, and Profiles 
buttons from the CHECK-RAS main window depending upon the number of profiles 
selected in the previous step.  Click the Report button to view the Summary Tables 
and messages for each check.  The Report button will display only the results from 
the last check. To view other checks, click the Report menu from the main window 
and select the check to view. 

A brief explanation of each menu is provided in Section 3.4 “CHECK-RAS Main 
Window.” A detailed explanation about the checks is provided in Chapter 4 “Description 
of CHECK-RAS Programs.” 

NOTE: The user should consider following conditions when creating HEC-RAS 
report file: 

	 The cross sections must be from upstream to downstream direction in the 
user table, CHECKRAS 

	 Select the reaches from Profile Table window under option menu if all 
multiple reaches are to be evaluated. 

 It is recommended to use the version 2.2 of HEC-RAS program. 

 You must regenerate the HEC-RAS report file when you modify HEC-RAS plan. 
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3.3 Creating a HEC-RAS Report File for Subsequent Runs 

Through the procedure described above, the CHECKRAS Table is inserted in the User 
Tables. However, if the CHECKRAS table is not inserted for some reason, users can 
create the table by including the following variables and checking the appropriate boxes 
in the Additional Options window, as shown in Figure 6 below. This enables users to 
create a HEC-RAS report file through the HEC-RAS main window from which the 
CHECK-RAS program can extract the data. The CHECKRAS Table includes variables 
that are not available from the Standard Tables or from the Detailed Output data. The 
variables in the CHECKRAS Table are: 

 Froude # Chl, 

 Top Wdth Act, 

 Conv. Total, 

 Prof Delta WS, 

 Left Sta Eff, 

 Enc Sta L, 

 Center Station, 

 Enc Sta R, 

 Rght Sta Eff, and 

 Min Ch El. 

The Left Stagn (Left Stagnation Station) and Rght Stagn (Right Stagnation Station) in 
the CHECKRAS Table are inserted by HEC-RAS because the Get Multiple Opening XS’s 
box in the Additional Options window is checked, as shown in Figure 6 below. 
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Users should review the CHECKRAS Table to make sure that all the variables are in the 
table and the appropriate boxes are checked in the Additional Options window. 

Figure 6. Additional Options Window for CHECKRAS Table in HEC-RAS 

After checking a plan with CHECK-RAS program and if you wish to check a different 
plan, you can open HEC-RAS without closing CHECK-RAS. 

Please follow the steps below to create a HEC-RAS Report File for other plans while the 
CHECK-RAS main window is open: 

1.	 Open the HEC-RAS project file from HEC-RAS.  (CHECK-RAS does not include an 
option to run HEC-RAS.) Run the selected Plan. 

2.	 Click the File menu on the HEC-RAS main window and select Generate Report. The 
boxes that must be checked in the Report Generator window are shown in Figure 4 
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on page 9. The user must check the following boxes from the Input Data area in the 
Report Generator window, if they are not checked. 

 Plan Data,


 Flow Data,


 Geometric Data,


 Manning’s n Values,


 Reach Lengths, and


 Contraction and Expansion Coefficients.


If the desired profiles are not displayed under Profiles To Include In Report, click the 
Set Profiles button, and then select the profiles. 

The user must check the following boxes from the Specific Tables Detailed Output 
area if they are not checked. 

 Cross Section Table, 

 Culvert Table, 

 Bridge Table, 

 Conveyance Table, and 

 Weir Table. 

Do not check Flow Distribution box. 

Under the Selected Summary Tables box, only CHECKRAS must be displayed. 
Otherwise, select CHECKRAS from the Available Summary Tables box. 

Do not check Summary of Errors, Warnings, and Notes box. 

Click the Generate Report button.  After the report is generated, click the Close 
button.  Click the Save Project option under the File menu. 

3.	 Close the HEC-RAS Program main window.  You now have a HEC-RAS Report file 
ready to be extracted by the CHECK-RAS program. You must reselect the project 
again from the CHECK-RAS main window.  You can select the project by clicking the 
File menu or click the Open button. Follow steps 6, 7, and 8 from the “Running 
CHECK-RAS” section above to check the HEC-RAS Report file. 
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3.4 CHECK-RAS Main Window 

To access the CHECK-RAS main window, click the Start button from the Windows 
95/98/NT taskbar, point to Programs, point to CHECK-RAS, and click on the 
CHECK-RAS icon. The CHECK-RAS opening screen will briefly display, and the 
CHECK-RAS main window (as shown in Figure 1 on page 7) will appear. 

The CHECK-RAS main window displays the Menu Bar, Tool Bar, and Status Bar. 

3.4.1 Main Menu Button Bar Description 

The Main Menu Bar includes File, Data, Checks, Report, and Help menus. 

File Menu 

The File menu includes the following commands: 

 Open HEC-RAS Project: displays the Open File window at default directory 

	 Project Information: displays the selected project, plan, geometric, and flow file 
numbers 

 HEC-RAS Setup: locates the path for “ras.exe” file, and the default directory 

 Print: prints report file for each check 

 Previous Projects: displays up to four previous projects selected by the user 

 Exit: closes the CHECK-RAS program 

Data Menu 

The Data menu includes the following commands: 

 Extract Data from HEC-RAS: extracts data from the HEC-RAS Report file


 Select Surcharge: displays the Select Allowable Surcharge window


 Select Profiles: displays the Select Profiles window


 Run HEC-RAS: displays the HEC-RAS program window
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Checks Menu 

The Checks menu includes the following commands: 

NT Check: The NT Check command will invoke CHECK-RAS to perform the following 
tasks: 

 Generate Summary Table 

 Generate Summary of Statistics Table 

 Check roughness coefficients at cross sections 

 Check transition coefficients 

 Check roughness coefficients at structures 

XS Check: The XS Check command will invoke CHECK-RAS to perform the following 
tasks: 

 Generate Summary Table


 Check distance between cross sections and junctions


 Check ineffective flow options


 Check special conditions


 Check location of cross section


 Check location of discharges


 Check boundary conditions


 Check flow regime


Structure Check: The Structure Check command will invoke CHECK-RAS to perform 
the following tasks: 

 Generate Summary Table


 Check distances between the structure sections


 Check type of flow


 Check culvert coefficients


 Check culvert solution criteria


 Check bridge coefficients


 Check bridge solution criteria
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 Check ineffective flow stations and elevations 

 Check deck/roadway data and ground data 

 Check floodway at the structure 

Floodway Check: The Floodway Check command will invoke CHECK-RAS to perform the 
following tasks: 

 Generate Summary Table


 Check encroachment method


 Check starting water-surface elevation of floodway profile


 Check encroachment stations


 Check surcharge values


 Check floodway discharges


Multiple Profiles Check: The Multiple Profiles Check command will invoke CHECK-RAS 
to perform the following tasks: 

 Generate Summary Table


 Check boundary conditions


 Check crossing of water-surface elevations between profiles


 Check discharges


 Check top widths


Reports Menu 

The Reports menu allows the user to view the CHECK-RAS reports generated after each 
checking program is run. 

The Reports menu includes the following commands: 

 NT


 XS


 Structure


 Floodway


 Multiple Profiles
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Help Menu 

The Help menu includes the following commands: 

 About-

 CHECK-RAS Help 

3.4.2 Tool Bar 

The Tool Bar includes Open Project, Extract Data, NT, XS, Floodway, Structure, 
Profiles, and Report buttons. The functions of the buttons are as follows. 

 Open Project: displays the Open File window 

 Extract Data: extracts data from HEC-RAS Report File 

 NT: runs Roughness and Transition Loss Coefficients Checking Program 

 XS: runs Cross Section Checking Program 

 Structure: runs Structure Checking Program 

 Floodway: runs Floodway Checking Program 

 Profiles: runs Multiple Profiles Checking Program 

 Report: displays the Report File of the last check 

Clicking on a button will invoke CHECK-RAS to execute the task. The function of each 
button appears as the mouse passes over the button. 

3.4.3 Status Bar 

The Status Bar displays the current program and project filename. 
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3.5 Select Profile Window 

The Select Profile window displays after CHECK-RAS extracts the data from the HEC-
RAS Report File, or when clicking the Data menu and the Select Profile option from the 
CHECK-RAS main window. The Select Profile window is shown as Figure 5 on Page 
10. There are three different types of profiles that the CHECK-RAS program will 
analyze.  These include: 

 Single Profile (100-year Profile), 

 Floodway Profile, and 

 Multiple Profiles. 

CHECK-RAS performs different checks depending upon the selected profile. 

CHECK-RAS will analyze 

 NT, XS, and Structure Checks for Single Profile, 

 NT, XS, Structure, and Floodway Checks for Floodway Profiles, and 

 Multiple Profiles Check for Multiple Profiles. 

The items in each check are explained in detail in Chapter 4 “Description of CHECK-
RAS Programs.” 

After extracting the data from the latest plan of the HEC-RAS project file, the Select 
Profile window displays the list of profiles under the plan. In order to select the profiles 
easily, assign the profiles names, such as “10-year profile,” “50-year profile,” “100-year 
profile,” “500-year profile,” and “floodway profile,” when running the HEC-RAS plan. 

100-year Profile (Single Profile): Select this field for streams without floodways. Select 
the 1% annual chance (100-year) profile to review flood insurance related studies. For 
other studies, any single profile can be selected. 

First, click on the circle in front of 100-year Profile and click on the corresponding 
profile from the list of profiles displayed in the box. 

Floodway Profile: Floodway analysis should be performed for streams with floodways. 
First, click the circle in front of 100-year Profile and click the corresponding profile from 
the list of profiles displayed in the box. Then, click the circle in front of Floodway Profile 
and the corresponding profile from the list of profiles displayed in the box. The user 
should recognize the correct profiles. 

When the Floodway check button is selected from the main window for floodway 
analysis, a message box will appear to select a default surcharge value of 1.0.  If No 
button is selected, then the Select Allowable Surcharge window will appear with States 
that have allowable surcharge value less than 1.0 foot.  Click on the State to select the 
allowable surcharge for the current analysis. 
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Multiple Profiles: Profiles in the Multiple Profiles box should be selected if the results 
among the profiles are to be compared.  CHECK-RAS Multiple Profiles check compares 
the boundary conditions, water-surface elevations, discharges, and top widths among 
the profiles. 

Users can select up to four profiles.  Selected profiles must have discharges in an 
increasing order. The user must not select the floodway profile for the Multiple Profiles. 

First, click the circle in front of 10-year Profile and click the corresponding profile from 
the list of profiles displayed in the box. The same procedure should then be followed to 
select other profiles. 

If the selected profiles are ready to be used, click the OK button.  If any of the profiles is 
to be changed, click the circle in front of the desired profile and click the profile from the 
list of profiles displayed in the box. 

If the user wishes to change the name of the profiles, first close the Select Profiles 
window, and then close the CHECK-RAS main window. Then open the HEC-RAS 
program, click Steady Flow Data, and select File, Rename Flow Title. After renaming the 
profiles, rerun the plan. 

3.6 Select Allowable Surcharge Window 

After the user selects two profiles to be checked from the Select Profile window and 
selects Floodway or Structure check from the main window, the following dialog box will 
appear. 

Figure 7. Allowable Surcharge Option Message in CHECK-RAS 

If the user selects No, the Select Allowable Surcharge window as shown below will be 
displayed.  If the user inadvertently clicks Yes and wants to change the allowable 
surcharge value, the user can open the Select Surcharge window again by clicking the 
Data menu and Select Surcharge option from the CHECK-RAS main window. Click on 
the State to select the maximum allowable surcharge value and click OK button. This 
value will be used to check against the computed surcharge values. 
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Figure 8.  Select Allowable Surcharge Window in CHECK-RAS 

3.7 CHECK-RAS Report File Window 

The CHECK-RAS Report File window will be displayed when the user clicks on the 
Report menu and selects one of the checks or clicks on the Report button after running 
a check. Users can print the report file from Print option under File menu. There is no 
button or option to close the Report File window.  If you want to view another check, 
simply click on the desired check button, then click on the Report button. The 
Summary Table in Report file for NT check is displayed in Figure 9 below. 
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Figure 9.  Report File Window in CHECK-RAS 

3.7.1 Help Messages Dialog Box 
Each reported message has a Message ID that consists of the two-letter check identifier 
followed by two letters representing the type of check and two numbers for the number 
of message. 

By clicking on the line in the report file that contains the Message ID, the Help 
information will be displayed in the CHECK-RAS Help Message dialog box for that 
particular Message ID.  The user can search for multiple Help Messages by clicking lines 
with the Message ID in the report box.  Help information for message NT RC 03 is 
displayed in Figure 10 below. 
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Figure 10.  CHECK-RAS Help Message Dialog Box 

If the Help information in the CHECK-RAS Help Message dialog box is referenced to 
another Message ID, the user can drag the mouse over the referenced Message ID and 
release.  The referenced Message will be opened to the top of the Message Box. 

The help message(s) can be printed from the File menu of the CHECK-RAS Help 
Message dialog box.  All the messages and Help information for each message are 
written in “Checkras.txt” file.  If the user has selected the default directory to install the 
CHECK-RAS program, “Checkras.txt” file is in “C:\Program Files\Checkras” directory. 
Users are encouraged to print the entire file for easy reference. 

In some cases, the problem flagged by CHECK-RAS may be a justifiable modeling 
approach, even though it may be outside the normal limitations of the HEC-RAS 
program. In these instances, explain the reasoning for the use of the data and modeling 
approach in the report file. The user can simply type the reasons in the report file. To 
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prevent the file from being overwritten by subsequent runs, the user should rename the 
report file using different primary and extension names.  The primary name of the 
CHECK-RAS report file is the project name, and the extension for NT check is “nt,” for 
XS check “xs,” for floodway check “fw,” for structure check “br,” and for multiple profiles 
check “mp.” The study contractors or requesters should include the renamed CHECK-
RAS report file when submitting flood insurance studies and revisions to FEMA. 
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Chapter 4: Description of CHECK-RAS Programs 

Within CHECK-RAS, there are five programs used to verify information for the hydraulic 
model: 

1.  NT Check evaluates roughness (Manning's "n") and transition loss coefficients. 

2. 	 XS Check evaluates distances, blocked obstructions, critical depth, ineffective flow 
areas, levees, divided flow, extended cross section, known water-surface elevation, 
location of cross sections, placement of discharges, boundary conditions, and flow 
regimes. 

3. 	 Structure Check evaluates distances, type of flow, culvert coefficients, culvert 
solution criteria, bridge coefficients, bridge solution criteria, ineffective flow, 
deck/roadway and ground data, and floodway at the structure. 

4. 	 Floodway Check evaluates the encroachment method, starting water-surface 
elevation, encroachment stations, surcharge values, and floodway discharge. 

5. 	 Multiple Profiles Check compares the starting water-surface elevation methods, 
crossing of water-surface elevations, discharges, and top-widths for two to four 
profiles. 

Each check is discussed in detail in the following sections. 

4.1 NT Check 

Summary Table: A Summary Table for all cross sections is created by the NT Check 
Program consisting of 7 columns, as follows: 

  River Station,


  Type of Structure,


  Left Overbank "n" Value,


  Channel “n” Value,


  Right Overbank "n" Value,


  Contraction Loss Coefficient, and


  Expansion Loss Coefficient.


When the horizontal variation in “n” values option is used and the left overbank, right 
overbank, and channel "n" values are specified by more than one value, each "n" value 
is shown on one line so that it can be easily seen from the table that multiple "n" values 
are used at that section. 
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Summary of Statistics Table: This table is also generated by the NT Check Program 
and includes the maximum and minimum values for roughness coefficients of the left 
and right overbanks and the channel from all cross sections in the input file. It also 
shows the maximum and minimum values of contraction and expansion loss 
coefficients. 

Roughness Coefficients at Cross Sections: The following checks evaluate roughness 
coefficient values used at cross sections that are not at structures.  A detailed 
explanation of these checks can be found under the Help menu. 

 	 Checks whether left and right overbank "n" values at each cross section are 
between 0.035 and 0.200. 

 	 Checks whether channel "n" values at each cross section are between 0.025 and 
0.100. 

Transition Loss Coefficients: The following checks evaluate transition loss coefficient 
values used at all cross sections in the HEC-RAS input file.  A detailed explanation for 
each of these checks can be found under the Help menu. 

 	 Checks whether the contraction loss coefficient is equal to 0.3 and the 
expansion loss coefficient is equal to 0.5 at Sections 2, 3, and 4 of the structure. 

 	 Checks that the transition loss coefficients used are 0.1 and 0.3 at cross 
sections that are not sections 2, 3, and 4 of the structure. 

Roughness Coefficient at Structures: 

 	 Checks whether the channel "n" values at Sections 2 and 3 of the structure are 
less than the channel “n” value of Sections 1 and 4, respectively, by 0.005. 

 	 Checks whether the channel "n" values downstream and upstream of an internal 
bridge opening section are equal to or larger than the channel “n” value of 
Sections 2 and 3, respectively. 

4.2 XS Check 

Summary Table: The summary table generated by the XS Check Program consists of 
the following 6 columns: 

  River Station, 

  Left Overbank Distance, 

  Right Overbank Distance, 

  Channel Distance, 
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  Total Discharge, and 

  Flow Codes. 

The flow codes are represented by “B” for blocked obstruction, “C” for critical depth, “D” 
for divided flow, “E” for extended cross section, and “K” for known water-surface or 
energy elevation. 

Reach Distances:: The following checks are made under Reach Distances Check: 

  Length across the junction is not equal to zero 

 	 Whether both the left and right overbank distances at each cross section are 
greater than the channel distance 

 	 Left overbank, right overbank, and channel distances specified at each cross 
section are equal to zero 

 	 Whether a ratio of 5:1 is exceeded at any cross section between the right 
overbank and the channel distance and the left overbank and the channel 
distance. 

Cross-Section Spacing: The program checks the following five variables for each cross 
section: 

  Change in velocity head (HV) value exceeds 0.5, 

  Conveyance change (Kratio) is outside the range of 0.7 and 1.4, 

  Water depth changes by a factor of 1.1, 

  Floodplain topwidth (TopWdthAct) varies by a factor of 2, 

  Distance between two cross sections is more than 500 feet. 

If all the above conditions are satisfied, additional cross section(s) should be inserted 
between the cross sections. 

Ineffective Flow: The program checks whether the following options are selected or 
used at a river station: 

  Levee


  Normal Ineffective Flow


  Multiple (blocked) Ineffective Flow
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Special Conditions: The program prints letters representing special conditions at river 
stations in the Summary Table. 

  Letter “B” represents blocked obstruction. 

  Letter “C” represents critical depth. 

  Letter “D” represents divided flow. 

 	 Letter “E” represents extended cross section where the computed water-surface 
elevation exceeds the elevation of the starting and end stations specified of the 
ground data. 

  Letter “K” represents known or changing water-surface or energy elevation. 

Location: Checks whether the cross section upstream of a critical depth cross section is 
located at a distance no greater than the topwidth of the critical depth cross section. 

Discharge: The following checks are made under Discharge Check: 

  Discharges decrease in the downstream direction 

  A constant discharge is used for the entire profile 

  The same discharge is used at the downstream and upstream side of a structure 

 	 A value of zero discharge shifts between the left and right overbanks between 
any two consecutive cross sections 

Boundary Condition: The program provides the following information regarding friction 
slope method and starting conditions at the downstream and upstream boundaries. 

 	 A friction slope method other than the average conveyance method is used and 
there are channel lengths more than 500 feet within the model. 

  Known water-surface 

  Energy slope 

  Critical Depth 

  Elevation-discharge relationship 
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Flow Regime: The program verifies whether the profiles are computed as: 

  Super critical flow regime, or 

  Mixed flow regime. 

4.3 Structure Check 

Summary Table: A Summary Table is created by the Structure Check Program that 
consists of the following 7 columns: 

  River Station,


  Maximum Low Cord Elevation,


  Minimum Road Elevation,


  Energy Gradient Elevation,


  Water-Surface Elevation,


  Minimum Channel Elevation, and


  Type of Structure.


Distance: Checks whether the distance between Section 3 and the upstream face of the 
structure and the distance between downstream face of the structure and Section 2 are 
less than the height of the opening. 

Type of Flow: The following checks are made under Type of Flow Check: 

 	 The type of flow at structure is either low flow, pressure flow, low and weir flow, 
or pressure and weir flow 

  Criterion used for computing pressure flow is upstream energy grade line 

 	 The pressure/weir method or energy method is used at a bridge when the type of 
flow is sluicegate pressure flow or sluicegate pressure and weir flow 

  The sluicegate Cd value has been specified by the user 

 	 The pressure/weir method or energy method is used at a bridge when the type of 
flow is submerged pressure flow or submerged pressure and weir flow 

 	 A default submerged Cd value of 0.8 is used when the type of flow is submerged 
pressure flow. 
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Culvert Coefficients: The following checks are made under Culvert Coefficients Check: 

  Entrance loss coefficient is specified properly 

  Exit loss coefficient is equal to 1.0 

  Culvert “n” value is specified properly 

Culvert Solution Criteria: The following checks are made under Culvert Solution 
Criteria Check: 

  “Highest U.S. EG” is selected as the criterion 

 	 EG at Section 3 is lower than the specified MinWeirFlowEl and higher than the 
MnTpRd 

Ineffective Flow: The following checks are made under Ineffective Flow Check: 

 	 Multiple (blocked) Ineffective Flow Areas option is used for single opening bridge, 
or a culvert group, or an inline weir 

 	 Normal Ineffective Flow Area option or Multiple (blocked) Ineffective Flow Areas 
option is used at Sections 1 and 4 of a structure 

 	 Ineffective flow elevations are higher than MnTpRd when weir flow occurs for 
Multiple (blocked) Ineffective Flow Areas 

 	 Ineffective flow area option is not considered at Sections 2 and 3 when pressure 
or low flow occurs at a structure 

  Ineffective flow elevation is specified properly at Sections 2 and 3 of a structure 

  Effective flow area is too narrow when pressure flow occurs at a structure 

  Ineffective flow stations are within the abutments of a structure 

Geometric Data: The following checks are made under Geometric Data Check: 

  Deck/Roadway data is aligned properly with the ground data 

 	 Low cord line crosses the ground line at more than two locations for single 
opening bridge or within the stagnation limits of a bridge opening for multiple 
opening analysis 

  Sections 2 and 3 are coded as narrowly as the bridge (culvert) opening 

 	 Section 3 centerline station differs from that of Section 2 when weir flow is not 
computed although EG at Section 3 is higher than MnTpRd, or the combination 
of Qweir and CulvQ is larger than Qtotal by 1% 
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 	 The MnTpRdD is higher than MnTpRdU if the combination of Qweir and CulvQ 
is larger than Qtotal by 1% 

 	 Centerline station of Section 3 differs from that of Section 2 if encroachment 
stations are not computed at the Culvert Section and Section 3 

  “Cross Section Lid” option is used at Sections 1, 2, 3, and 4 of a structure 

Floodway: The following checks are made under Floodway Check: 

  Encroachment method is specified at Section 3, Structure Section, and Section 2 

 	 Encroachment Methods 2 and 3 are specified at Section 3, Structure Section, 
and Section 2 

  Encroachment stations are within the abutment stations 

 	 Encroachment stations are within the channel bank stations at Section 3, 
Bridge section, and Section 2 

 	 Encroachment stations are computed at Section 3 when Encroachment Method 
1 is specified at the Structure Section, and Encroachment Method 4 or 5 is 
specified at Section 3 

 	 Negative surcharge value at Section 3, Bridge-Up Section, Bridge-Dn Section, 
and Section 2, is less than  –0.09 

 	 Surcharge value is more than the allowable surcharge value at Section 3, 
Bridge-Up Section, Bridge-Dn Section, and Section 2 

  Encroachment stations are within the 1% annual chance floodplain 

 	 Encroachment stations over the road for the culvert and the inline weir are 
within the weir stations of the natural profile 

4.4 Floodway Check 

Summary Table: The summary table generated by the Floodway Check Program 
consists of 7 columns. They are: 

  River Station,


  Encroachment Method,


  Surcharge Values,


  Natural/Floodway Water-Surface Top Width,


  Floodway Width,


  Channel Width, and


  Type of Structure.
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Encroachment Method: The following checks are made under the Encroachment 
Method Check: 

  Encroachment method is specified at the river station 

 	 Encroachment Methods 2 and 3 are used to compute the floodway 
encroachment stations 

 	 A target surcharge value for water-surface is not specified for Encroachment 
Methods 4 or 5 

 	 A surcharge target value greater than one foot or the maximum allowable 
surcharge value for the state where the stream is located is specified at any 
cross section 

Starting Water-Surface Elevation: The following checks are made under the Starting 
Water-Surface Elevation Check: 

 	 Starting water-surface elevation of the floodway profile is equal to the computed 
water-surface elevation of the natural profile plus the specified surcharge value 

 	 The difference in conveyance between the floodway profile and the natural profile 
is more than 1% 

Floodway Width: The following checks are made under the Floodway Width Check: 

  Encroachment stations are specified within the channel bank stations 

  Encroachment stations are outside the 1% annual chance floodplain 

 	 Channel bank stations are selected such that relatively flat overbank exists 
outside of the channel bank stations 

Surcharge Value: The following checks are made under the Surcharge Value Check: 

  Negative surcharge values exist in the floodway computations 

 	 Computed surcharge value exceeds the maximum allowable surcharge value at 
any cross section 

 	 “Change in WS or EG” option is used to specify the floodway water-surface 
elevation 

Floodway Discharge: Checks that the total discharge in the natural and floodway 
profiles are the same at every cross section. 
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4.5 Multiple Profiles Check 

Summary Table: The summary table generated by the program consists of the 
following 6 columns: 

  River Station, 

  Water-Surface Elevation, 

  Total Discharge, 

  TopWidth Actual, 

  Velocity Head, and 

  Profile Number. 

Boundary Condition: States the starting water-surface method for the downstream 
and upstream boundary condition for each selected profile. 

Discharge: Checks whether the discharges at a river station are in an increasing order. 

Crossing of Water-Surface Elevations: Checks whether the water-surface elevation of 
a lower discharge is higher than that of a higher discharge. 

Top Width: Checks whether the top width of a higher discharge is the same as that of a 
lower discharge, and if so, the velocity head for the higher discharge is more than 0.5 
foot. 
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